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MASTER Bias/Dark/Flat— Einfuhrung 1/1

Neben den Aufnahmen des Objektes (Light Frames) sind flur eine erfolgreiche
Bildbearbeitung auch Korrekturaufnahmen notwendig. Dazu gehdrt Bias, Dark
und Flat Aufnahmen.

Die Bias beinhalten das Ausleserauschen und die Darks das thermische
Rauschen des Aufnahmechips. Durch die Korrektur mit Bias / Dark werden
auch defekte Pixel entfernt und das Signal / Rauschverhaltnis im Bild
verbessert.

Mit den Helligkeitsbildern (Flats) werden unterschiedliche Helligkeiten im Bild
ausgeglichen, die durch Vignettierung, Verunreinigungen, wie Staubkérner auf
den optischen Elementen und unterschiedliche Empfindlichkeit der Pixel,
entstehen.

Im folgendem Tutorial wird gezeigt, wie man in PixInsight die Summenbilder
(PI bezeichnet diese Bilder als ,MASTER") der Korrekturaufnahmen erstellt.

Zur Anzahl der Einzelaufnahmen:
Bias - soviel wie mdglich (200 und mehr).

Dark - soviel wie méglich, selbe Temperatur und Belichtungszeit wie die Lights.

Flat - da reichen ca. 15 Einzelaufnahmen

Sinnvoll ist sicherlich auch eine Kontrolle der Einzelbilder , ev. der
Zwischenschritte und der erstellten Masterbilder, da Fehler in den
Korrekturbildern die Qualitat der Lights verschlechtern kann.

Der folgende Workflow gilt fir monochrome Chips.
Abweichende Einstellungen fur DSLR und Farb CCD sind extra angefuhrt.

Gray 1A WASTER BTAS | bias- BINNING 1 singie fit

i} Master Bias

Gray 124 MASTER_DARK | dark BINNING 1 EXPTINE 600_ cingbe fit

¢ Master Dark

Gray 14 MASTER FLAT (UM

¢ Master Flat

THat FILTER_ UM BINNING 1
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Toole MASTER Bias/Dark/Flat — Einzelbilder kontrollieren 1/1

Process > Imagelnspection > Blink

Bevor man mit der Erstellung

[ Gray 1:8 BlinkScreen | <*new*> - 4+ X

der Master Bilder beginnt, -
sollten die einzelnen Korrektur- :
bilder auf fehlerhafte Aufnah- -
men kontrolliert werden.
Dazu gibt es das Modul Blink.
Neben der optischen Kontrolle
bietet es auch die Méglichkeit,
Bildwerte wie Median, verwen- &
dete Filter bei Flats etc. aus- = : Biink = X
zulesen und auf Richtigkeit zu = e ——
Uberprifen. oozt 0. | 2 | 3 | 2 13 0] M| Fthed

fl 3 E 4 12 -10 LuM Flat Field

. 4 66 12 -10 LumM Flat Field

Beispiel: : o )| 12 0| um| Aeres
die Spalte Median zeigt die mittlere @ P % [020sec v| « f 4 12 40 LUM  FlatField
Bildhelligkeit an. Mit einem Doppel- e S e e e L
klick auf die Spaltenbezeichnung x 0 0 - - 12 A0 LM Flat Fied
werden die Werte auf- bzw. abstei- otz 0601 | 12 . | g | a0 5ok 12| 10| | recred
gend sortiert und ,Ausreiser' kénnen 2 e 2028 j ’ 1210 ) Rt

leicht identifiziert werden.

Bei DSLR Aufnahmen vorher
die Schritte von Folie 5 durch-
fiUhren. Dann werden die Bilder
in Graustufen dargestellt und
sind besser zu beurteilen.

Die Listeneintrage erstellt man mit dieser
Schaltflache. Beim Klick auf die Schaltflache 6ffnet
sich ein Fenster zur Auswahl der Spalteneintrage.

Weitere Info zum Modul Blink (Videotutorial)
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http://www.skypixels.at/downloads/videos/blink.mp4

Tools

MASTER Bias/Dark/Flat — Voreinstellung DSLR 1/1

Process > Imagelnspection > Blink

Bei der Verwendung von DSLR Kameras miussen als erster Schritt im Format Explorer folgende
Einstellung vorgenommen werden. Dadurch ist gewdhrleistet, dass die Bilddaten unverandert geladen
werden. Dazu 6ffnet man den Formatexplorer @ (View > Explorer Windows > Format Explorer) und
doppelklickt auf den Listeneintrag DSLR_RAW @ . Es 6ffnet sich ein Fenster @ und die Einstellungen sind

wie angegeben vorzunehmen.

@

File Edit View Image Preview Mask  Process  Script  Workspac

m =N e - e R

Image  Preview Mask  Process  Script  Workspace  Window

Explorer Windows

#¥  Process Explorer Ctrl+Al+P —

2 }- ProcessConsole  CtrlvAlt+C g

& E  Script Editor CHARE | View Explorer CRARY -

§ = Resk-TimePreview  CiieAltsT  /  History Explorer Crle AltH s I
£ T » Object Explorer Ctrl+Alt+0 -

2 v  Show ControlBars  CirleAksB W File Explorer Ctrl+Alt+F %

_E Default Control Bars Bl LoadView Explorer  Ctrl+Alt+ShiftsV 3

ug 8, Zoomln Ctri++ A Load History Explorer Crl+Alt+Shift+H :S

:
)
-3
E
)

Bei Aufnahmen von CCD (farb und monochrom) ist dieser Schritt nicht notwendig.

@™ RAW Format Preferences

White Balance

[] Use Auto White Balance

[] Use Camera White Balance

image (ne interpolation, ! E.
n creates a picture from the i |nterpu:u|ati|:|n is done and
is either red, green or blue, as defined by th: B
chrome image)
is done and
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Tools MASTER BIAS 1/2

Process > Imagelntegration> Imagelntegration

3] Imagelntegration = X

Ein MASTER BIAS wird mit dem Modul >Imagelntegration< erstellt.

auch-fuer-05-17_B

auch-fuer-05-17_B

EinfUgen der Einzelbilder — Add Files

AV VA U R N SR N RN

% 1rer G afe 7| [] Full paths

Format Hints

Parameter Wle Im B”d Image Integration @‘)

Combination: e
Nors <«
Para meter wie im Blld Don't care (all weights =1) |¥| &—

Generate integrated image

[] Generate a64-bit result image

Klick mit linker Maustaste auf die Schaltflache >Apply Global< L Evaluate n
(blaues Kreissymbol).

® & ® O

Jetzt wird das MASTER BIAS und 2 zusatzliche Bilder (rejection
low/high) erstellt und auf der Arbeitsflache von PixInsight
angezeigt.

Clip low range
Clip high range
Pixel Rejection (2)
Pixel Rejection (3)

[] Regicn of Interest

Herbert Walter - PixInsight 1.8 6



MASTER BIAS 2/2

@ MASTER BIAS: Benannt ist es integration. Zum Umbenennen,

O

doppelklick auf den Reiter und neuen Namen vergeben.
Achtung: Das Master Bias muss extra gespeichert werden!

™ Pidnsight 1.8 RC1

m Edit  Wiew Image  Preview  Mask

I # Open. Ctrl+0

2 Opena Copy.. Ctrl+Shift+0
®  Open Location... it [EEE 754
Open Recent » Embedded Data
Clear R » [[] 1CC Profile
\Metadata
ear Recent |:| et
B save Ctrl+S

[] Thumbnail Image
[] Fixed-pre n key

QK

Die Bilder zeigen jene Pixel, die durch die Einstellungen unter
Punkt 3 - s. Folie 6, Pixel Rejection (1) - beim Erstellen des
Masterbildes aussortiert wurden. Die Anzeige der Bilder kann

auch deaktiviert werden.

Pixel Rejection (1)

R algorithm: | Wins Sigma Clipping |~

ormal : | Scale + z

Pixel Rejection (2)
Pixel Rejection (3)
[] Region of Interest

h @

Rejection maps have pixel values proportional ta
the number of rejected pixels for each output
pixel. Low and high rejected pixels are
represented as two separate rejection maps,
which are generated as 32-bit floating point
images.

Use rejection maps along with console rejection
statistics to evaluate performance of pixel
rejection parameters.

[ @ Gray 1:3 integration | <*new*> - = + X

integration

[ Gray 1:3 rejection_low | <*new*>

= + X

rejection_low

]

- + X

@ Gray 1:3 rejection_high | <*new*>

rejection_high

B @y
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Tools MASTER DARK 1/2

Process > Imagelntegration> Imagelntegration

Ein MASTER DARK wird mit dem Modul >Imagelntegration< erstellt. *

EinflUgen der Einzelbilder — Add Files
Parameter wie im Bild

Parameter wie im Bild

® 60 6 8

Klick mit linker Maustaste auf die Schaltflache >Apply Global<
(blaues Kreissymbol).

Jetzt wird das MASTER DARK und 2 zusatzliche Bilder (rejection
low/high) erstellt und auf der Arbeitsflache von PixInsight
angezeigt.

* Die Erstellung eines Master Dark ist ident mit der Erstellung vom Master Bias
(dieselben Einstellungen!).

s f ﬂ_ Add Files
e Y saare

Select All

Invert Selection

Clear

- Full paths

Combinatio

Image Integration )

Morma

| Use file cache
Pixel Rejection (1)
on algorithm: | Wins

Normalization: | N
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MASTER DARK 2/2

Gl

[ . . Gray. ]..:7i.r|tegration | <"’ne“.r*> . - - z. + X
MASTER DARK: Benannt ist es integration. Zum Umbenennen, £ @ -
doppelklick auf den Reiter und neuen Namen vergeben. gl
Achtung: Das MASTER DARK muss extra gespeichert werden!
™ Pidnsight 1.8 RC1 @ FITS Options
Edit  Wiew Image  Preview  Mask e :
I ® Open.. e [ .Grav 1:.7 r.e.i.ection_lo;v | <*¥new*> = = + X
& Opena Copy. Ctrl+Shift+ O ;
®  Open Location... _g .
Open Recent » E
Clear Recent r .E
.! Save Ctrl+5 =

Die Bilder zeigen jene Pixel, die durch die Einstellungen unter
Punkt 3 - s. Folie 8, Pixel Rejection (1) - beim Erstellen des

Masterbildes aussortiert wurden. Die Anzeige der Bilder kann 5
auch deaktiviert werden.

[ Gray 1:7 rejection_high | <*new*> - = + X

rejection_hi

Pixel Rejection (1)

hm:

Rejection maps have pixel values proportional to

the number of rejected pixels for each output

pixel. Low and high rejected pixels are

Clip high range represented as two separate rejection maps,

Pixel Rejection (2) which are generated as 32-bit floating point
images.

Pixel Rejection (3)

Use rejection maps along with console rejection

] Region of Interest statistics to evaluate performance of pixel
rejection parameters,

h @

B &=y
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oole MASTER FLAT 1/3

Process > ImageCalibration > ImageCalibration
| - ImagecCalibration z x

Target Frames

Flr die Erstellung von einem MASTER FLAT sind zwei Arbeitsschritte : oL @
notwendig. 2 i ‘

Invert Selection
A) Einzelbilder mit dem Master Bias kalibrieren (>ImageCalibration)
B) Erstellen vom MASTER FLAT (>Imagelntegration).

a Clear

| [] Full paths

Format Hints

Output Files

@ Einfiigen der Einzelbilder - Add Files @_O“t”'““
Qutput sio
Sample fi
@ Angabe Ordner fiir die kalibrierten Bilder — Output Directory Output pedest
@ Master Bias laden On errr: | Continue v
Pedestal
[ Overscan
@  Klick mit linker Maustaste auf die Schaltflache >Apply Global< MasterBins (€})

(blaues Kreissymbol).

Jetzt werden die mit dem Master Bias korrigierten Einzelbilder
im Punkt @ angegebenen Ordner gespeichert. Im Bildnamen
steht am Ende der Zusatz _c (siehe Bild nachste Folie).

Monochromer Chip: MASTER FLAT muss fiir jeden Filter extra erstellt werden.

Herbert Walter - PixInsight 1.8 10



oole MASTER FLAT 2/3

Process > Imagelntegration> Imagelntegration

A) Einzelbilder mit dem Master Bias kalibrieren (>ImageCalibration)
B) Erstellen vom MASTER FLAT (>Imagelntegration).

Einfligen der kalibrierten Einzelbilder (*_c.fit) — Add Files

Parameter wie im Bild

Parameter wie im Bild

® ©® ® 9

Klick mit linker Maustaste auf die Schaltflache >Apply Global<
(blaues Kreissymbol).

Jetzt wird das MASTER FLAT und 2 zusatzliche Bilder (rejection
low/high) erstellt und auf der Arbeitsflache von PixInsight
angezeigt.

Monochromer Chip: MASTER FLAT muss fiir jeden Filter extra erstellt werden.

1

g

11
Format Hints

Image Integration

Buffer size (MEB):

Pixel Rejection (1)

Rejection

Mormalization:

@;_ Add Files
- il

Select All

Invert Selection

Clear

Full paths

| Generate integrated image

Generate a 64-bit result image

Equal

~| Generate reje:
¥| Clip le

~| Clip high pixels
~| Clip le

Herbert Walter - PixInsight 1.8
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MASTER FLAT 3/3

—

Gray 1:6 integration | <*new*> - o X

@ MASTER FLAT: Benannt ist es integration. Zum Umbenennen,
doppelklick auf den Reiter und neuen Namen vergeben.
Achtung: Das MASTER FLAT muss extra gespeichert werden!

integration

™ Pidnsight 1.8 RC1 @ FITS Options

Edit  View Image Preview  Mask Sample Format

I W  Open.. Ctrl+0O bit unsigned integer bit unsigned integer
2 OpenaCopy.. Ctrl+Shift+0 T €9¢ bit signed |nte3:r
- Open Location... g [P
Open Recent 4 [
C Profile [] Thumbnail Image
»
Clear Recent e [ Fixed-precisio
B save Ctrl+5

rejection_highl

]

Die Bilder zeigen jene Pixel, die durch die Einstellungen unter
Punkt 3 - s. Folie 11, Pixel Rejection (1) - beim Erstellen des

Masterbildes aussortiert wurden. Die Anzeige der Bilder kann
auch deaktiviert werden.

Gray 1:6 rejection_low1 | <*new*>

Gl

rejection_lowl

Pixel Rejection (1)

Rejection maps have pixel values proportional to
the number of rejected pixels for each output
pixel. Low and high rejected pixels are
represented as two separate rejection maps,
Pixel Rejection (2) wh\ch are generated as 32-bit floating point

- images.
Pixel Rejection (3)

- Use rejection maps along with console rejection
statistics to evaluate performance of pixel

rejection parameters,

h @

[[] Region of Interest

B 5 H

Monochromer Chip: MASTER FLAT muss fiir jeden Filter extra erstellt werden.

Herbert Walter - PixInsight 1.8 12



Script Batch Preprocessing Bias/Dark/Flat - S/W 1/4

Script > Batch Processing > BatchPreprocessing

Eine Alternative zu den Einzelschritten mit den Tools ImageCalibration und Imagelntegration, mit der man
wesentlich schneller und einfacher die Master Bias/Dark/Flat erstellen kann, bietet das Script
>BatchPreprocessing<. Im Bild die Einstellung fir einen monochromen Chip.

IFir DSLR / Farb CCD siehe Folie 16!!

1

Mit den Schaltflachen @ @ @ @ Batch Preprocessing Script v1.23

werden die Einzelbilder im e | D | i A srpt fo calibrtion and slgnment of light rames

linken Bereich des . —— 0 212

Scriptfensters eingefligt. S

2

Die Parameter im mittleren .

Bereich bleiben auf den , —

vorgegebenen Werten. IV
2-06 [] CFA images [] Up-bottom FITS

3 Sl = [] Optimize dark frames ~ [] Use master bias

Im rechten Fensterbereich o ez o it [130] ——t Ssshantiaglic heweiny
muss noch ein Ordner @ 2012-06-20--012

angegeben werden, wohin
die Master gespeichert
werden sollen.

4 . . .
Klick auf die Schaltflache

Run< @ @ @

¥ Binning1 Registration Reference Image

Bias und Dark kénnen auch getrennt zu einem Summenbild bearbeitet werden.
Flats bendtigen aber ein Bias bzw. Dark, ansonsten erscheint eine Fehlermeldung.

Herbert Walter - PixInsight 1.8 13



Script Batch Preprocessing Bias/Dark/Flat - S/W 2/4

Script > Batch Processing > BatchPreprocessing

@ Light Frames Integration Warning

NaCh dem Starten des Scrlpts erSCheInen 2 FenSter mlt You have selected to perform an integration of light frames with this script.
Warnhinweisen - das sind keine Fehlermeldungen!

Das Erste mit dem Hinweis, dass keine light frames vorhanden | e o
sind. Das ist korrekt — es wurden ja keine Lights ausgewahit.
Mit OK bestatigen.

Das Zweite mit dem Hinweis, das Master Lights besser mit dem
Imagelntegration Tool erstellt werden. Auch dieser Hinweis ist
korrekt, aber bei der Erstellung von Korrekturbildern nicht von
Bedeutung.

Mit Continue bestatigen.

v Herbert » Astrophotos » QSLmd5 » bbp_master » master
Datei  Bearbeiten Ansicht Extras 7
Jetzt lauft das Script und erstellt fir die Korrekturbilder die Organisieren v In Bibliothek aufnehmen v Freigebenfur v Brennen
Master Frames, die im angegebenen Ordner abgespeichert 4B Herbert “ MName "
werden. 1 AppData %, bias-BINNING 1 fit

darl EXP

-09_Auswahl

4 || QSLmds

4 || bbp_master

. calibrated

. master

Herbert Walter - PixInsight 1.8 14



Script Batch Preprocessing Bias/Dark/Flat - S/\W. 3/4

Script > Batch Processing > BatchPreprocessing

4]

Beim Offnen eines Master Bildes 6ffnen e
sich auch die beiden Rejection Bilder,
die im Fitsheader vom Masterbild
gespeichert sind.

flat_FILTER_LUM_BINNING_1

Im BatchPreprocessing Fenster kann
diese Option aktiviert bzw. deaktiviert
werden.

Options

~| Generate rejection maps Use master dark
~| Export calibration files Use master flat

Ob die Option angewahlt ist oder nicht,
hat keine Auswirkung auf die Erstellung
der Master Bilder, sondern bewirkt nur

die Anzeige der Rejection Bilder.

88Xy

Herbert Walter - PixInsight 1.8
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Batch Preprocessing Bias/Dark/Flat - DSLR/Farlb CCD 4/4

Fiir DSLR / Farb CCD
Bei Bildern einer DSLR / Farb CCD ist unter Options @ CFA images zu aktivieren, im Bereich DeBayer @

das Bayer pattern der Kamera einzustellen (fir Canon Kamers gilt generell RGGB), DeBayer method: VNG.

Das ist der einzige Unterschied in den Einstellungen im Vergleich zu einer monochromen CCD.

@ Batch Preprocessing Script v1.23 E

Bias | Darks | Flats A script for calibration and alignment of light frames
| Bias | Dars | Fiats | ptfor catbr

right Niechen.

right (c) 2012 Pleiades Astropheto.
¥ Binningl 3 Remove Selected nvert Selection right (<) 2012 Pleiades Astroph

¥ 361.00s
- [] Calibrate enly

Cosmetic Correction

DeBayer

Bayer/mosaic pattern: | RGGB -

omemeroswe____|v] || Mcamgs | @ 0 vparomens
Ll

Optimize dark frames [] Use master bias

Image Registration Generate rejection maps || Use master dark
o ) Export calibration files ] Use master flat

Clamping threshold: e tion Reference Image

Image Integration
Apply

¥ Integration parameters...

Herbert Walter - PixInsight 1.8
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ANHANG Bias/Dark/Flat - ANALYSE 1/4

In der Process Console sind die erfolgten
Arbeitsschritte aufgelistet und teilweise auch mit
Zahlenwerten versehen.

Im Bild ist ein Beispiel flr den Prozess
Imagelntegration.

In der markierten Zeile wird die Anzahl der
entfernten Pixel in absoluten Zahlen und in %,
bezugnehmend auf die Gesamtanzahl der Pixel im
Bild, angegeben.

In der Klammer befinden sich die Werte getrennt
fur die low und high Rejection (Anzahl der Pixel
und Prozentwerte).

Frocess Consale

-
¥

g
E
=

—

&) Farmat Explorer ﬁ Frocess Explorer

Object Explorer . File Explorer

lScript Editor

Rejection parameters ...... sigma_low=4.080 sigma_high=2.008
* Using 1261 concurrent pixel stack(s) = 975.95 MB
Integrating pixel rows: 8 -= 1260: done

Integrating pixel rows: 1261 -> 2583: done

Pixel rejection counts:

C:/Users/Herbert/Astrophotos/QSI_mas/Flat_QSI_2012-06-30_LRGE/R/flat_2012-06-36- -061R.

il £ 233837 2.808% ( 5348 + 228489 = 0.064% + 2.744%)

(]

2. 231318 2.777% ( 5380 + 225938 = 0.065% + 2.713%)

]

- 2285081 2.744% ( 5449 + 223052 = 0.065% + 2.678%)

(s

4 229650 2.757% ( 5431 + 224219 = 0.065% + 2.692%)

s

227576 2.733% ( 5496 + 222088 = 0.066% + 2.667%)

(s

6 : 231136 2.775% ( 5419 + 225717 = 0.065% + 2.710%)

s

2209424  2.755% ( 5408 + 224076 = 0.865% + 2.601%)

[

3 : 230893 2.772% ( 5379 + 225514 = 0.065% + 2.708%)

(s

229344  2.754% ( 5486 + 223858 = 0.066% + 2.688%)

s

10 : 232591 2.793% ( 5416 + 227175 = 0.065% + 2.728%)

o

11 : 230672 2.770% ( 5413 + 225259 = 0.065% + 2.705%)

C:/Users/Herbert/Astrophotos/QSI_ma5/Flat_QSTI_2012-86-30_LRGB/R/flat_2012-06-30--012R.

12 : 232115 2.787% ( 5496 + 226619 = 0.066% + 2.721%)

C:/Users/Herbert/Astrophotos/QSI_ma5/Flat_QSI_2012-06-30_LRGB/R/flat_2012-06-30--013R.

15 £ 229801 2.759% ( 5581 + 224228 = 0.067% + 2.692%)

C:/Users/Herbert/Astrophotos/QSI_mas/Flat_QSI_2012-06-30_LRGB/R/flat_2012-06-20--014R.

14 : 230624 2.769% ( 5446 + 225178 = 0.865% + 2.704%)

C:/Users/Herbert/Astrophotos/QSI_ma5/Flat_QSI_2012-06-30_LRGE/R/flat_2012-06-36- -015R.
e . AAnnaT ~ wono. [ cE A . Ancenc n oneTo. B DT T

Total : 3459769 2.769% ( 81690 + 3378079 = 0.065% + 2.704%)
MRS nolse evaluation: done.

Computing noise scaling factors: done.

Gaussian noise estimates:
s = 1.721e-08683

Reference SNR increments:
Ds@ = 1.5397

Average SNR increments:

:/Users/Herbert/Astrophotos/QSI_m45/Flat_QSI_2012-06-30_LRGB/R/flat_2012-06-30- -082R.
:/Users/Herbert/Astrophotos/QSI_mas/Flat_QSI_2812-06-38_LRGB/R/flat_2012-086-38- -083R.
:/Users/Herbert/Astrophotos/QSI_m45/Flat_QSI_2012-06-30_LRGB/R/flat_2012-06-30- -084R.
:/Users/Herbert/Astrophotos/QSI_ma5/Flat_QSI_20812-06-38_LRGB/R/flat_2012-06-38- -085R.
:/Users/Herbert/Astrophotos/QSI_m45/Flat_QSI_2012-06-30_LRGB/R/flat_2012-06-30- -086R.
:/Users/Herbert/Astrophotos/QSI_ma5/Flat_QSI_2012-06-38_LRGB/R/flat_2012-06-30- -087R.
:/Users/Herbert/Astrophotos/QSI_m45/Flat_QSI_20812-06-38_LRGB/R/flat_2012-06-30- -088R.
:/Users/Herbert/Astrophotos/QSI_m45/Flat_QSI_2012-06-38_LRGB/R/flat_2012-06-30- -B80R.
:/Users /Herbert/Astrophotos/QSI_ma5/Flat_QSI_2812-06-30_LRGB/R/flat_2012-06-36- -016R.

: /Users /Herbert/Astrophotos/QSI_m45/Flat QSI 2012-06-3@ LRGE/R/flat 2012-06-30--011R.

fit
fit
fit
fit
fit
fit
fit
fit
fit
fit
fit
fit
fit
fit

fit

Herbert Walter - PixInsight 1.8
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ANHANG Bias/Dark/Flat - ANALYSE 2/4

@

B %X

fiat_FILTER_LUM_BINNING 1

Beispiel: MASTER FLAT

Die Darstellung am Bildschirm zeigt nicht die wirklichen Helligkeitsverhaltnisse im Bild. Das Bild ist mit
ScreenTransferFunction gestreckt und es hat den Anschein, dass die Ecken ,schwarz' sind.

Mit Previews und dem Modul Process > Image >Statistics erhalt man genaue Angaben zu den
Helligkeitswerten im Bild.

In diesem Beispiel betrigt das Helligkeitsgefalle Bildmitte @ zu Bildecke ® ~5%.

Das ist wesentlich weniger als man aufgrund der Bildschirmdarstellung vermuten wiurde.

Preview 2 - Median: 26994.826
Flat A Medlan: 26460.272 7.'7 Gray 1:4 flat_FILTER _LUM_BINNING 1 | flat-FILTER_LUM-BINNING_1.fit -z 4 X.

®

Gray 1:4 flat_FILTER_LUM_BINNING_1 | flat- FILTER_LUM-BINNING_1.fit - % X

‘ Preview 1 - Median: 25688.139

Gray 124 flat_FILTER LUM_BINNING. 1 | Hat-FILTER LUM-BINNING 1At -z %X

Previewd ]

2 | Statistics T X

[ flat FILTER LUM_BINNING 1
: t Range: | 16-bit [0,65535]

R TR0 fet FILTER LUM_BINNING 1

I flat_FILTER_LUM_BINNING 1->Previen01

K
Mean 26416.132
Median 26460.272
AvgDev  343.645
Stdoev  404.929
Variance 163967.125
Minimum 19039.030
MinPos  1587,287
Maximum 28015.217

Range: | 16-bit [0,65535]

K
25693.453

n  25688.139

v 111.795
138.795
19264.113
25152.0560
340,121

Mean 26994.520
Median  26994.826

26234.803
MaxPos 267,423 5 AvgDev  73.159 s 20,320
5 Stdpev  91.747
a Variance 8417.584
_ - Minimum  26540.359
o MinPos 505,290

Maximum  27371.532

B¢

MaxPos 120,88

HY Xy
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ANHANG Bias/Dark/Flat - ANALYSE 3/4

Beispiel: MASTER FLAT [ Gray 1:7 flat_FILTER_LUM_BINNING_1 | flat FILTER_L... = = # X |28 HistogramTransformation = X

Die mittlere Helligkeit eines Bildes
misst man mit dem Modul Statistics.

@  Einstellen des Zahlenbereichs ™

flat_FILTER_LUM_BINNING_1

@ Der Medianwert gibt die mittlere

Helligkeit des Bildes an (ADU) Ressh @h o s
Die Sattigung eines Flats ist im “
Histogramm ersichtlich. i Statistics T X

[ flat_FILTER_LUM_BINNING_1_single

® Optisch: die Position der Kurve im 1 cientfc notation __ Range: [ Nomnalized Real0) [v] D) @(

horizontalen Bereich entspricht der o
Sattlgung in 0/0. Dle Mltte |St 500/0. AvgDev .8B52437

.0eBEe382

5]

¢]
StdDev 0.0861788

Variance 8

8

@ Messen: Bewegt man den Cursor in die

Minimum

s = - .2905178 , - R
Mitte der Kurve wird ein Zahlenwert MinPos 1587287 "

angezeigt (0.4037 entspricht 40,37%). Maximum  ©.4274848

MaxPos 267,423

(*)

PixInsight verwendet standardgemaB zur Darstellung von Zahlenbereichen einen normierten Zahlenraum von 0 bis 1
[0,1] (O=schwarz, 1=weiB). Der Vorteil liegt darin, dass Zahlenwerte unabhangig von der bit-Tiefe (8/12/16bit)
dargestellt werden kénnen, somit absolut und damit vergleichbar sind.

Der Wert im obigen Beispiel fir Median von 0.4037579 ADU entspricht im 8bit Zahlenraum 102,96 ADU und in der
16bit Darstellung 26460,27 ADU (255 x 0,4037579 bzw. 65535 x 0,4037579)
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ANHANG Bias/Dark/Flat - ANALYSE 4/4

Beispiel: MASTER FLAT

Von Gerald Wechselberger gibt es ein Makro, welches den Helligkeitsverlauf im Bild graphisch darstellt.

i

Macro_Check_Flatness: ProcessContainer

NE

o !
z 3
2
&

Makro Profile.xpsm abspeichern, rechter Mausklick auf die Arbeitsflache von PI > Load Process Icons ...

Prozess Icon auf das Bild ziehen - wird auf Original angewandt - daher vorher kopieren.

Infos zur Anwendung dieses Makros Video (~24MB) Homepage von Gerald Wechselberger

Herbert Walter - PixInsight 1.8
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ANHANG Bias/Dark/Flat - Parameter 1/2

H ImagelIntegration X
BIAS aP DARK Input Images 2
@_ Add Files

ct All

election

Clear

LA R

Full paths

Aarle 011 fit

Format Hints mat Hints

Image Integration @)

Combination: &
MNermalization: | No normalization v é

ghts: | Don't care (all weights=1) |+ %

nerate integrated image

Image Integration
Combination: age
Mormalization: | No normalization

ight: 't care (all weight:

+| Generate integrated image

[] Generate a 64-bit result image Generate a 64-bit result image

["] Evaluate noise

s images

ejection zlgorithm: | Win Sigma Clipping

Mo normalization - Normalization: | No normalization -
Generate rejection maps | Generate rejection maps
v| Clip
~| Clip high p

lip low range | Clip low range
lip high range | Clip high range
Pixel Rejection (2)

Pixel Rejection (3)

[ ] Region of Interest
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ANHANG Bias/Dark/Flat - Parameter 2/2

| - ImageCalibration z X
1 - F LAT Target Frames 3 2 L F LAT Uil =
calibration @] swrie | integration

-

@;_ Add Files
il

Select All

Wk e

Wk

[ Y
[ =Y

A T T T A

Seled

=
- o

SR

10
11 f . Full paths

Clear

[r=}

Format Hints
Format Hints

Image Integration @)

Combination:

Output Files
Output directo

Output extensio
Normalization: | Multiplica

Weights: | Don't care (all weights = 1) |+ %

Sample format:
Output pedes
| Generate integrated image
Generate a 64-bit result image

Evaluate r

On error: | Continue ¥

Pedestal previous images

[] Overscan 16
1024

ry
-
ry
-

v| Usefile cache

jection algorithm: ed Sigma Clipping

I nalization: fl

Generate rejection maps

p low range

Clip high range

Region of Interest

FS
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ANHANG Bias/Dark/Flat — Arbeltsschritte 1/1

Erstellen der Master Bias, Dark, Flat in Einzelschritten

Monochrom CCD:

1. Imagelntegration — Bias (> Master Bias)

2. Imagelntegration — Dark (> Master Dark)

3A. ImageCalibration - Flat (> Flat calibriert, *c.fit) - fur jeden Filter L/R/G/B!
3B. Imagelntegration - Flat (> Master Flat) - fur jeden Filter L/R/G/B!

Farb CCD:

1. Imagelntegration — Bias (> Master Bias)

2. Imagelntegration — Dark (> Master Dark)

3A. ImageCalibration - Flat (> Flat calibriert, *c.fit)
3B. Imagelntegration - Flat (> Master Flat)

DSLR

1. Einstellungen Format Explorer — nur flir DSLR (siehe Folie 5)
2. Imagelntegration — Bias (> Master Bias)

3. Imagelntegration — Dark (> Master Dark)

4A. ImageCalibration - Flat (> Flat calibriert, *c.fit)

4B. Imagelntegration - Flat (> Master Flat)

Herbert Walter - PixInsight 1.8
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ANHANG - Arbeltsschritte LIGHTS 1/1

Vollstandigkeitshalber und als Vorschau fur das nachste Tutorial die Arbeitsschritte zum Erstellen der Lights.
Die Nummerierung schlieBt an die Aufzéhlung der Arbeitsschritte fiir Bias, Dark, Flat an.

Erstellen Master Lights L/R/G/B MONOCHROM CCD

4. ImageCalibration - Light
5. ImageRegistration - Light
6. Imagelntegration - Light

Erstellen Master Light FARB CCD

4. ImageCalibration - Light
5. Batch Debayer - Light

6. ImageRegistration - Light
7. Imagelntegration - Light

Erstellen Master Light DSLR

5. ImageCalibration - Light
6. Batch Debayer - Light

7. ImageRegistration - Light
8. Imagelntegration - Light
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MASTER Bias/Dark/Flat

Damit sind Master Bilder flr Bias, Dark und Flat erstellt, alles kontrolliert und tUberprift - somit kann man
die Korrekturbilder ruhigen Gewissens fur die Kalibrierung der Lights verwenden.

MASTER BIAS DARK FLAT

ENDE
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